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APA 7th Edition Guidelines: Student Papers 
APA stands for the American Psychology Association and often is used in Social Science, 
Medical, Business, and Art fields. The information and guidelines in this handout follow APA 
Publication Manual (APA Manual), 7th edition. This manual describes two perspectives, the 
professional and student. This guide follows the student perspective when addressing how to 
format the document, cite sources, and create a reference page.  
 

FORMATTING THE DOCUMENT 

 Margins – All margins should be one inch. Go to the toolbar at the top of the screen.   
Click the Layout tab.  Click the Margins icon.  Click Normal with top, bottom, left, and right 
all saying 1”.  
 

 Line Spacing – Double space entire paper including title page, abstract, text, headings, block 
quotes, reference list, etc.  Click the Home tab. In the Paragraph section, click the icon with 
the Up and Down Arrows. A menu will drop down. Click 2.0. Make sure to select remove 
spacing before and after paragraph from this menu.  

 
 Justification – Justification refers to the alignment of the text.  All text should be aligned 

left. The alignment buttons are located in the Paragraph section of the Home tab. Do not use 
full justification. Note: some text will be centered if it is a title. 

 
 Font type and size – APA guidelines allow a variety of font types; however, it recommends: 

11-point Calibri, 11-point Arial, 11-point Georgia, and 12-point Times New Roman. Font 
style should stay consistent throughout the paper.  

 
 Page Numbers – Place page numbers in the upper right-hand corner of every page, from the 

Title Page to the Reference Page. To apply page numbers, click the Insert tab and find Page 
Number#: select the following options: Top of Page/Plain # 3. 

 
 Abstract – The abstract follows the title page and is a summary of the paper. On the first 

line, center Abstract in bold. Abstracts are one paragraph, left aligned with no indents. They 
are usually limited to 250 words or less and are not typically required by the professor.  

 
 Text (body) – The body always starts on a new page following the title page. Left align the 

text with 0.5 inch indents for each paragraph and double-spaced lines. On the first line of the 
page,  write the title of the paper in title case, bold, and centered, for example: 

 
The Standards of APA Format 

 APA Style guidelines have both a professional and student perspective. This handout will 

reflect the student side of academia with respect to college papers. Some rules in APA may be 

enforced by the professor that are not required from the student perspective; therefore, it is 

always a good idea to double check with your instructor in regards to specific requirements.  
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 Title Page – Students should follow the instructions below to format the title page unless their 

professor has given different guidelines. (Adapted from APA Manual, 2019, p. 22) 
 

Sample Student Title Page 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

  

 

 
 

NOTE: All student essays will contain page numbers, a title page, text (introduction, body 

and conclusion), in-text citations, and a reference page. APA style papers may also present 

charts, graphs, tables, bulleted information, and figures. Again, student papers do not 

require a running head, an author note, or abstract. Always ask your professor about these 

elements.  

 

         1 
         

               

 

A Glimpse of the Title Page 

 

Shayla A. Student 

Division of Social Sciences, Oklahoma City Community College 

PSY 2603: Psychology of Women 

Professor Shauna R. Murray 

June 14, 2021 

Page Number 

Paper Title 

Author(s) 

Affiliation 

Course 

Instructor 

Due Date 



3 
 
 APA Headings – Headings are used to help the reader easily navigate through the 

document’s sections. All headings are written in title case and boldface; however, only the 
main heading (level 1) is centered. APA consists of 5 different levels of headings although 
student papers typically only showcase 3 levels. Below is an example of what one might 
look like: 

 
A Closer Look at Headings 

According to APA Manual, “Headings in a document identify the topic or purpose within 

each section. Headings help readers become familiar with how a paper’s content is organized” 

(2020, p. 47). Additionally, Keep headings concise but with enough detail to describe the 

content.  

Heading Level 2 

 The level 2 section is a sub-claim of the main heading in Level 1. It is indented and uses 

bold formatting. Also, make sure to align the level 2 heading to the left.  

Heading Level 3. 

 Level 3 heading is a sub-claim of Level 2 and has the same formatting except this 

heading is italicized and ends with a period. 

 
The Second Main Heading 

 

(APA Manual, 2019, p. 48, Table 2.3) 

 

APA Headings 

Level Format 

1 Centered, Boldface, Title Case Heading 
     Text begins as a new paragraph. 

2 Flush left, Boldface, Title Case Heading 
     Text begins as a new paragraph. 

3 Flush Left, Boldface Italic, Title Case Heading 
     Text begins as a new paragraph. 

4          Indented, Boldface Title Case Heading Ending With a Period. Paragraph text continues 
on the same line and continues as a regular paragraph.  

5         Indented, Boldface Italic, Title Case Heading Ending With a Period. Paragraph text 
continues on the same line and continues as a regular paragraph.  

Level 1 Heading 

Level 1 Heading 
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CITING SOURCES IN-TEXT 

An in-text citation is created each time a writer uses information from a source in their own 
paper. The purpose of the in-text citation is to give credit to the author within the sentence and 
ultimately to help avoid plagiarism. Note: paraphrases do not require a location such as a 
page number in the in-text citation but direct quotes do. (See pg. 7 of this guide). 
 
 In-text Citations – APA Style uses the author and date for citing in the text. However, for 

direct quotes, the page number, chapter, section, etc., will also be added. In-text citations 
have two formats: parenthetical and narrative. The parenthetical citation appears in 
parenthesis at the end of the sentence and the narrative citation typically begins the sentence. 
Below are the two examples: 
 

Parenthetical Citation- Effective leadership includes “leaders who choose to inspire rather than 
manipulate in order to motivate people” (Sinek, 2009, p. 37). 

• (author last name, most current year, specific part). 
 
Narrative Citation- In the book The Power of Habit Duhigg (2014) states, “Social habits are why 
some initiatives become world-changing movements, while others fail to ignite” (p. 217).  

• Author name and year in parenthesis are placed in the sentence while the page number is 
in parenthesis at the end of the sentence.  
 

 Unknown Author – If a source does not explicitly say “Anonymous,” cite according to its 
title and year for both parenthetical and narrative citations. APA guidelines ask that direct 
quotes provide the specific location such as page number. (See page 7). For example: 
 

Website Example- According to the Center for Disease Control, a family who sits down during 
mealtime models eating behaviors to the child and helps with social development (“Mealtime 
Routine and Tips,” 2020). 

• Titles of works found on websites, magazine and news articles, and works inside a 
compilation of multiple authors are placed with quotation marks around the title.  

 
Religious Work Example- Biblical scripture argues that “all is vanity” in reference to earthly 
pleasures and possessions (King James Bible, 1999, Eccl. 1:2). 

• Books, films, albums are shown italicized.  
 

 
NOTE: The formatting in the intext citation and reference page stay consistent. If the intext 
citation shows italics, then, the source on the reference page will also appear in italics. If the source 
is cited according to its title with quotation marks, the entry on the reference page will also show 
quotation marks.  

 
 

period ends the citation 
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 Anonymous as Author – Sources can have an anonymous author when no author can be 

found and the source clearly states “Anonymous.” If this is the case, follow the example 
below: 

 
Anonymous Parenthetical Citation- (Anonymous, 2018). 
 
 Multiple Authors – Works with various authors use unique formatting. A work can also be 

represented by a group such as an organization, agency, or institution. Refer to the table 
below for directions on citing sources with multiple authors. 

 

Author type Parenthetical citation Narrative citation 

One Author (Luna, 2020) Luna (2020) 
Two Authors (Salas & D’Agostino, 2020) Salas and D’Agostino (2020) 
Three or More Authors (Martin et al., 2020) Martin et al. (2020) 
Group Author with 
Abbreviation first citation 
 
Subsequent citations 

(National Institute of Mental 
Health [NIMH], 2020) 
 
(NIMH, 2020) 

National Institute of Mental 
Health (NIMH, 2020) 

Group Author without 
Abbreviation (Stanford University, 2020) Stanford University (2020) 

(APA Publication Manual 7th ed., Table 8.1) 

 Same Author and Date – When works share the same author and date, use a lower case 
letter starting with “a” to distinguish the sources from each other on the reference page.  

 
Same Author Citation- (Nelson & Starwalt, 2021a), (Nelson & Starwalt, 2021b) 

 
 Authors with Identical Surname – Often, when conducting research, a writer will come 

across sources that share the same last name. When that happens, use the examples below to 
help format the citation. 

 
Same Name Different Initials:  (L. Jackson, 2021. p. 52)… (J. Jackson, 2020) 

Same Surname Same Initials:   Leslie Jones (2020) states…  Lee Jones (2021) says, … 

Same Last Name Single Source: (Smith & Smith, 2020, p.100)… Smith and Smith (2020) 

 
 Multiple Works Cited Parenthetically – A writer may use more than one source to build a 

paragraph. When this happens, alphabetically list the author’s last name and date separated 
by semi-colons (;). Below is an example. 
 

Citing Multiple Works- (Duhigg, 2014; Sinek, 2009; Snow, 2010) 

• If the sources being cited use “et al,” list in chronological order 
• If using narrative citation, put in any order 

 



6 
 
 Secondary Sources/indirect Quotes – APA recommends that a writer use a primary source 

whenever possible. However, if a secondary source is used, note the original source in the in-
text citation, then, the secondary source shown “as cited in” within the same parenthetical 
citation. Add year for each source. For example, the article, “The Inequality of the 
GoFundMe Economy,” uses facts from an academic source. If a person were to use 
information from this article, it would look like the following: 
 

Secondary Source Example- Social injustices do exists as “there is a long history in social crises 
for people who need the help the most being last in line to get it” (Igra et al., 2021, as cited in 
Ovide, 2021). 

• Only the secondary source is added to the reference page not the primary source. 
 
 Interviews – These sources are put into three categories: published, personal, and research 

participants. Published interviews are found in magazines, newspapers, TV shows, 
transcripts of videos/audio recordings, YouTube videos, and podcasts. To cite a published 
interview, follow the format for the reference type. For example:  
 

Published Magazine Interview- During an interview with The Politic, Mark Cuban states, “I’m 
competitive. I want to win. I want to reach my goals” when asked about the motivation behind 
achieving his dreams (Dalal, 2016). 
 
 Personal Interview- When asking a student about online classes, she states, “If I had the 
discipline, online classes would be great because of the flexibility of schedule” (V. Blackwell, 
personal communication, January 4th, 2020). 

• Since this information cannot be verified, cite personal interviews as personal 
communication. (See “Personal Communication” below for details.)  
 

Interview from Research Participant- To gain knowledge on student writing patterns, research 
was conducted by asking tutors in OCCC Writing Center to share observations of past tutoring 
sessions. Participant Josh Shultz, Writing Tutor, stated that “students do not know how to qualify 
a claim.” In fact, most of the tutors agreed that students were confused with this element of the 
Toulmin argument.  

• Make sure to state in the text that the research comes from participants. Since this 
information is work conducted by the author, it will not need an in-text citation or cited 
on the reference page.  

 
 Personal Communication – According to APA Publication Manual (2019), works that 

cannot be recovered by readers are cited in the text as personal communication such as 
emails, text messages, online chats or direct messages, personal interviews, telephone 
conversations, live speeches, unrecorded classroom lectures, memos, letters, etc. Use the 
initial and last name of the communicator. Personal communications are not posted on the 
reference page. 
 

Narrative Citation- J. Shultz (personal communication, June 17, 2021) states,  

Parenthetical Citation- (L. Eades, personal communication, May 5, 2020) 

 

https://www.nytimes.com/2021/06/21/technology/gofundme-online-giving.html
https://www.nytimes.com/2021/06/21/technology/gofundme-online-giving.html
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 Paraphrases – Often, writers put borrowed information into their own words instead of 

quotes. A paraphrase may be comprised of many sentences. Therefore, cite the paraphrased 
information the first time it is being mentioned. Once the work has been cited, the citation 
does not need to be repeated as long as it is clear within the context of the paraphrase that 
the citation is being continued (APA Manual, 269). 

 
Narrative Style Citation- In his book Lessons from the Mouse, Snow (2010) claims that making a 
guest’s experience memorable is empowering and that acts of kindness toward these guests, in 
return, creates loyalty. 

Parenthetical Example- There are many ways to create fun on the job. For example, one should 
not take themselves too seriously. Look through the lenses of an amusing or playful eye; then, 
one can see the humor in life (Snow, 2010).  

• Providing a specific location is not required for paraphrases although it does help the 
reader easily find source material.   

 
 Direct Quotes – When quoting directly from the source, quote the borrowed material 

verbatim (word for word) enclosing the quote with quotation marks. The quote should match 
exactly even if the quote has errors. (See APA Manual, p. 274, 8.29). Quotes in the paragraph 
should not exceed 40 words. Cite direct quotes by using the author name, date, and specific 
location in the same sentence as the quote. Use the example below to format in-text citations 
for direct quotes. 

 
Direct Quote Example- Duhigg (2014) argues that “Good leaders seize crises to remake 
organizational habits” (p. 178). 

Parenthetical Quote No Page Number- In life, two types of people seem to exists, the optimist 
and the pessimist; however, “Pessimists are usually right and optimists are usually wrong but all 
the great changes have been accomplished by optimists” (Friedman, 2005, “Freidman Quotes”). 

• The first example is from a printed book with page numbers. However, the second 
example is from a website that has no specific location. Follow the table below for citing 
works with no apparent location.  

 

Direct Quotes without Page Numbers 

Provide a heading or section name (Jones, 2019, Know Thyself section 

     Abbreviated heading or section name 
(Center for Disease Control and Prevention, 
2008, “Tornados” section). 

     Heading/section name with paragraph number (Nguyen, 2021, Health section, para. 4). 

Offer the paragraph number (count if needed) (Drake, 2020, Ch. 8, para. 3). 

Give timestamps for audio (TED Talk, YouTube…) (White, 2021, 1:45). 

Numbered Section from religious works…) (New King James, 1985/2012, Mark 2:3). 

Numbered sections from plays- act, scene, lines (Shakespeare, 1591, 1.3.8-10). 
 
 



8 
 
 Indirect Quote – When a writer quotes information from a secondary source, they are 

creating an indirect quote. Always strive to use primary sources even if it means tracing the 
information back to its origin. However, secondary sources can be good sources to use as 
long as the source is credible. To cite indirectly, include the primary source name in the in-
text citation. Then, add the secondary source shown “as cited in” within the parenthetical 
citation. Add year for each source. 

 
Indirect Quote Example- Which is better one might ask, the pessimist or the optimist? Some 
believe pessimists prepare for the worst, but that it is the optimist who “changes the world” 
(Friedman, 2005, as cited in Sinek, 2010). Therefore, one should aspire to have a positive 
outlook.  
 

• Only the secondary source is added to the reference page not the primary source. 
 
 Changes to Quotations Allowed – Using a quote may require alterations to its text. Some of 

these changes can be done without any explanation while other instances will. Below are 
examples of changes that can be made without any explanation. 
 
A. The first letter of a sentence, whether upper or lower case in the quote, may be altered to 

fit the needs of the writer. 
B. Punctuation may be changed. A writer should delete or add any punctuation that makes 

the sentence grammatically correct.    
C. Single quotation marks may be altered to double quotation marks as well as double 

quotation marks may be changed to single quotation marks. (“…” to ‘…’) and vice versa. 
D. Footnote and endnote callout numbers can be omitted. (APA Manual, 274-275, section 

8.30) 
 
 Changes to Quotes with Marking – Some changes to a quotation require an explanation. 

Therefore, a writer will use certain markings for different situations, for example, to place 
emphasis, add material, or omit material. Omitting material from a quote requires the use of 
ellipsis (…) in the place of the missing words. To place emphasis, italicize the word with 
“emphasis added” immediately following enclosed in brackets. If a content needs to be 
added, use brackets. Review the different situations in the essay below: 

 
 

 

 

 

 

 

 

• If an error is spotted in the quote, leave the error and follow it with [sic] 
 

Duhigg (2010) expands upon the idea of how habits are formed through 
peer pressure. He argues that “the habits of peer pressure, however, [emphasis 
added] have something in common. They [habits] often spread through weak ties. 
And, they gain their authority through communal expectations” (p. 225). The 
ideas is “If you ignore the social obligations of your neighborhood… you risk 
losing your social standing (Duhigg, 2014, p. 225).   
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 Block Quotes – When a quotation contains more than 40 words, a block quote should be 

used. Question marks are not need for a block quote and may contain more than one 
paragraph. Block quotes always start on a new line and are indented 0.5 inches from the left 
margin. The entire block quote should also be double spaced. A writer can use a narrative 
style or a parenthetical citation to develop a block quote. To format a block quote, see the 
examples below. 

 
Parenthetical Example: In this example, the writer constructs a complete sentence followed by a 
colon (:), enters down to the next line, and indents the entire quote 0.5 inches from margin. A 
quick indention tip is to press Ctrl, Tab after placing the cursor in front of the first line (for 
Windows users)   

 
A good argument can be made for loyalty over incentives:  

Energy can always be injected into an organization to motivate people to do things. 
Bonuses, promotions, other carrots and even a few sticks can get people to work harder, 
for sure, but the gains are, like all manipulations, short-term. That’s not loyalty. That’s 
the employee version of repeat business. Loyalty among employees is when they turn 
down more money or benefits to continue working at the same company. Loyalty to a 
company trumps pay and benefits. (Sinek, 2009, p. 134-135) 

 

Narrative Example: The narrative style block quote also leads with a topic sentence but with the 
author and year situated within the sentence.  

When delving deeper into the ideas of why a person acts in such a way, Sinek (2009) compares 
energy with charisma: 

Energy motivates but charisma inspires. Energy is easy to see, easy to measure and easy 
to copy. Charisma is hard to define, near impossible to measure and too elusive to copy. 
All great leaders have charisma because all great leaders have clarity of WHY; an 
undying belief in a purpose or cause bigger than themselves. (p. 134) 

 

 

NOTE: A paper should not contain too many block quotes, and it is always a good idea to 
ask the professor about the use of one before inserting a block quote in the paper.  
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CREATING A REFERENCE PAGE 

The References page is the last page of the document where a writer lists all of the references 
they used to develop its content. A writer will enter specific details about each reference as an 
“entry” on the Reference page; these details are known as “elements.”  
 
Basic Rules for References 

 Any information used in the essay that is not one’s own ideas will be added.  
 The Reference page is located by itself on the last page of a document and has a page 

number: enter down from the last sentence of the conclusion to create the next page for 
“References.” 

 For the title, the term References is centered at the top of the page with no special 
formatting.     

 Only the first line of each source entry will be aligned to the left.   
 The second, third, fourth, lines or more that follow will be indented, .05 from left margin.  
 To indent, use a hanging indent from the ruler or CTRL, TAB. Search “hanging indent” 

on YouTube for tutorial.   
 The entire page is double spaced. 
 Sources on a reference page should be ordered alphabetically.  
 “The,” “A,” “An” are not typically used as the first words on the Reference page: “Price 

is Right, The.” 
 Carefully follow the punctuation and formatting when using this guide. Pay close 

attention to: periods, commas, quotation marks, spacing, bold and italicized text.  
 Author names follow a last name, first initial format:  

Smith, J.  
 Middle initials always follow the first name initial:  

Smith, J. K.  
 References with no date use: (n.d.)  
 Use a retrieval date when …: Retrieved January 18 2022 from http://writingcenter/ 
 APA references are cited in this order: author, date, title, and source  

 
Consider the 4Ws: WHO, WHEN, WHAT, WHERE 

• AUTHOR Who created this work? Who should get credit for their contribution?  
-This can be an author/authors, editor, group or organization  

• DATE When was this work published? Is there a copyright date, date created, last 
revised, or any other type of date?  

• TITLE What is the title of this work? 
• SOURCE Where can this work located? On a website? In a magazine or newspaper? 

Page number, Doi number, URL (weblink)? 

 
Source information may have two parts: the publisher and specific information about the source. 
If the source is a book, only use the publisher information. Otherwise, include these details: 
name of the source, volume number, issue number, page, number, doi number and/or weblink.   
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References are divided into four groups. To create a citation, find which type of source is being 
used; then, follow the same numbered example below: 
 

1. Textual Works - 
Print and Online 

2. Data Sets, Software, 
and Tests 

3. Audiovisual   
Media 

4. Online Media  
 

Articles from 
Newspapers, 
magazines, journals; 
books, chapter books, 
reports, literature, 
conference sessions, 
dissertations, theses, 
reviews of other works, 
and unpublished and 
informally published 
works 

Computer Software, 
mobile apps, 
apparatuses, and 
equipment; tests, 
scales, and inventories, 
unpublished raw data, 
test scoring manual 
 

Film, Video, TV Series, 
YouTube video, music 
album, radio 
broadcast, Podcast, 
Art Work in museum 
and on a website, 
photograph, and 
PowerPoint slides   

Basic Websites and 
Webpages, Social 
Media website, 
Instagram, Twitter , 
LinkedIn… 

 
References contain multiple elements that make up an entry on the reference page. Those entries 
are always double spaced and in alphabetical order. Adjustments may need to be made to the 
reference page citation if a writer is not able to locate some of those details. Just skip the element 
when that information is missing and move to the next detail. 

 
1. Textual Works: Page 316, APA Manual 7th edition 

Book: Author or Editor. (date). Title. Publisher. doi number or url (weblink) 

Duhigg, C. (2014). Power of habit. Random House Trade Paperbacks.  

Chaptered Book: Author. (date). Chapter title. Editor, Book title. Publisher, doi or url  

Schick, K., & Schubert, L. (2017). How do arguments work? In Frederick Speers (Ed.), So 
What?: The writers argument (2nd ed., pp. 69-96). Oxford Press University. 

Journal: Author. (date). Title of work. Journal, volume(issue), page number, doi, or url 

Gupta, J. (1998). Leadership in the climate regime: Inspiring the commitment of developing 
countries in the post-kyoto phase. Review of European Community & International 
Environmental Law, 7(2), 180. https://doi.org/10.1111/1467-9388.00145 

Newspaper: Author. (date). Title. Newspaper name, volume(issue), page number, doi, or url 

Sheridan, M. B. (2022, May 21). In Cuba, a frantic search for milk. Washington Post. 
https://www.washingtonpost.com /world/interactive/2022/cuba-economy-milk-
shortage/?itid=hp-more-top-stories 

Dictionary, Thesaurus, or encyclopedia 

Merriam-Webster. (n.d.).  Merriam-Webster.com dictionary. Retrieved May 25 2022, from 
http://www.merriam-webster.com/ 
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2. Data sets, Software, and Tests: Page 337 in APA Manual 

Data Set: Author or Group. (date). Title of data set (version) [Data set]. Publisher. doi or url  

Pew Research Center. (2022). Number of student U.S. statehouse reporters [data set]. 
https://www.pewresearch.org/fact-tank/2022/05/19/in-some-states-students-account-for-
a-large-and-growing-share-of-statehouse-reporters/ft_22-05-10_statehousestud ents_bar/ 

Economic Research Service. (2022). Changes in food price indexes [data set]. U.S. Department 
of Agriculture. https://www.ers.usda.gov/data-products/food-price-outlook/ 

• When the name of the author and publisher are the same, omit the publisher.  

Unpublished Data: Author/Group. (date). [Unpublished raw data Title of data set]. doi, url, org  

Nelson, T. (2021). [raw unpublished data that reports online tutoring sessions for month of 
October 2021]. Oklahoma City Community College, Writing Center.  

Software: Author. (date). Title of entry. Publisher. url 

Borenstein, M., Hedges, L., Higgins, J., & Rothenstein, H. (2010). Comprehensive meta-analysis 
(Version 3.3070) [Computer Software]. Biostat. http:// meta-analysis.com/ 

Mobile App: Author. (date). Title of entry 

Bible Hub. (2016). Berean Study Bible [Mobile app]. Google Play Store.  

3. Audio Visual Sources: page 341, APA Manual.  

The author of an audiovisual reference differs depending on the media type. Always state the 
media type in brackets after the title element: How men think [Podcast]. Use the table below to 
determine the author type: 

Media Type Author Type 
Film Director 
TV Series Executive Producer(s) 
TV Series Episode Writer and Director of Episode 
Podcast Host or Executive Producer(s) 
Podcast Episode Host of Episode 
Webinar Instructor 
Classical Music Album or Song Composer 
Modern Music Album or Song Recording Artist 
Artwork Artist 
Online Streaming Video (YouTube) Person or Group who uploaded the Video 
Photograph Photographer 

 

Film: Director. (date). Title of film [Film]. Production Company. url 

Darabont, F. (1994). Shawshank redemption [Film]. Castle Rock Entertainment. 
https://www.imdb.com/title/tt0111161/  
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TV Series Episode: Writer and director of episode. (date). Title of episode (season number, 
episode number) [media type description]. Executive Producer(s), title of TV series. Production 
company. url 

Lorre, C., (Writer) & Cendrowski, M. (Director). (2012, January 19). The recombination 
hypothesis (Season 5, Episode 13) [TV series episode]. In Prady, B., & Molaro, S. 
(Executive Producers), Big Bang Theory. Chuck Lorre productions; Warner Bros; 
HBOMax.  

Online Video/YouTube: Video Host. (date). Title of video [Description]. Site name. url 

Kable, R. (2017, December 2). 5 simple tips for mindfulness in everyday life [Video]. YouTube. 
https://www.you tube.com/watch?v=6A-CTt5xPNQ 

TED Talk: Host name. (date). Title of video [Description]. Streaming site name. url 

Purushothaman, D. (2022, March). The workplace, redefined by women of color [Video]. TED 
Conferences. https://www.ted.com/talks/deepa_purushothaman_the_ workplace_re 
defined_by_ women_of_color 

TED. (2012, January). Skill of self confidence [Video]. YouTube. https://www.youtube.com/ 
watch?v=w-HYZv6HzAs 

Single Song/Track: Artist or composer. (date). Song or track title [Description]. Album. Label. 
url. 

Combs, L. (2020, October 23). Forever after all [Song]. On What you see ain’t always what you 
get. Columbia Nashville; River House Artists.  

Artwork: Artist. (date). Title of work [Description]. Museum name, museum location. 

Winslow, H. (1882). Mending the nets  [Watercolor painting]. National gallery of art, 
Washington DC. https://artsandculture.google.com/asset/mending-the-nets-winslow-
homer/dQGvacgwnBTXMg?hl=en 

• For works with no title, give a general description of the piece to use as the title.  

Photograph: Author. (date). Title of photograph [description of photo]. location 

Horsey, D. (2022, June 3). Cartoon on climate change: Big toilet bowl [Political cartoon]. U.S. 
New and World Report. https://www.usnews.com/news/cartoons /2019/02/01/ cartoons-
on- climate- change-and-global-warming  

PowerPoint Slides/PDF or lecture notes: 

Michalczyk, M. (2016). What is culture [PowerPoint slides]. Square space. https://static1.square 
space.com/static/55810da1e4b040cf35c0222c/t/5737415fb6aa607768dd6529/146323901
5245/Cultural%2BAwareness%2Band%2BSensitivity%2B2016.pdf 
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4. Basic Website and Online Media: page 348, APA Manual 7 ed.  

Online media refers to general webpages/websites that do not fit any other criteria and social 
media websites such as Twitter, Facebook, and Instagram. Always use original content from 
social media websites. For example, if a link is posted in Facebook, do not cite Facebook but the 
origin of the link provided. General mentions of a website do not need to be cited. However, 
the writer will note the name of the website in the text and place the weblink in parenthesis.  

Ex. Students used a citation generator from Purdue Owl (https://owl.purdue.e 
du/owl/purdue_owl.html) to cite their sources.  

Basic Website: Author. (date). Title of work. Website/Webpage name. url 

Bruton, A. (2022, June 5). Peace walk hopes to highlight local black community in NE Oklahoma 
City. News9. https://www.news9.com/story/629d413acd5cb20728f6a710/peace-walk-
hopes-to-highlight-local-blac k-community-in-ne-oklahoma-city 

• A website may contain many webpages. If you cite multiple webpages from a website, 
create an entry for each one on the Reference page 

 
Website Group Author: Group Name. (date). Title of work. url 

WebMD. (2022). 12 habits of super healthy people. https://www.webmd.com/fitness-
exercise/ss/twelve-habits-super-healthy-people 

Website No Author: Title. (date). Website Host. url 

Pet wellness and preventative care. (2022). Family VetCare. https://familyvetcare.com/fun-facts/ 

Basic Webpage No Date: Author. (n.d.). Title of work. Site name. url 

Nelson, T. (n.d.). Mission of the writing center. Oklahoma City Community College. 
https://www.occc.edu/writingcenter/ 

Instagram Photo/Video: Author or group [@user name]. (date). Up to first 20 words of content 
[Description]. Site name. url 

Reggie C Fitness [@reggiecfitness]. (n.d.). Independent, do you know what that means. She got 
her own house; she got her own car. Two job, work hard [Video]. Instagram. http://www. 
tiktok.com/t/ZTdv47jD2/?k=1 

Tweet: Author/Group [@username]. (date). Up to first 20 words hashtags [Tweet]. Twitter. url 

Myriad Botanical Gardens [@myriadgardens]. (2022, June 6). We are starting to plant large trees 
in the conservatory #conservatoryreimagined [Tweet]. Twitter. https://twitter.com 
/myriadgardens?ref_src=twsrc%5Egoogle%7Ctwcamp%5Eserp%7Ctwgr%5Eauthor 

 

 

 

 


